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Tonality: Will Putney has been developed by STL Tones and Will Putney to capture every aspect of what makes
Putney’s guitar and bass tones so distinctive. The plugin suite takes your direct input guitar signal to a fully mixed
guitar tone with its unique all-in-one plugin design.

Using the most advanced modeling algorithms, users can experience real-time simulations of Will Putney's actual
amps. Our software uses internal circuit simulations from the schematics of the specific amplifiers he uses in the
studio every day. Experience an all-access pass to Will Putney’s mix-ready guitar tones from some of their biggest-
selling records.

Will Putney is an American producer, mixer, and engineer based in Jersey City, New Jersey. He has worked with
many prominent bands, most notably Every Time | Die, The Amity Affliction, The Acacia Strain, Body Count, Thy Art Is
Murder, Northlane, Gojira, Silent Planet, After the Burial, For Today, Stray From The Path and Counterparts.

Full discography can be viewed at http:/graphicnatureaudio.com/.
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Tonality: Will Putney comes in 64-bit VST3, VST2, AU, AAX, and standalone plugin formats.

Latest OS Compatibility for Windows & Mac, including Native Apple Silicon

Minimum Requirements Mac OS 10.13 or Windows 7

STL Licensing System, no iLok account required.

3 activations are available per user.

NOTE: During recording or monitoring, we recommend a buffer size of 128 samples or lower. This low buffer size is to
minimize latency and improve the play-through experience. This can be set in your audio interface setup utility or your
DAW audio settings.
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Tonality: Will Putney is available in the following plugin formats, compatible with the noted Digital Audio Workstation
(DAW) platforms:

- VSTS3, VST2 (Cubase, Studio One, Ableton Live, and Reaper)
- AU (Logic, Garage Band, and Luna)
- AAX (ProTools)

Tonality: Will Putney software can also be used as a standalone application. The Standalone version is perfect for
practice on the go and for use in live situations.
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- Always use the high impedance (Hi-Z) input of your interface. This will ensure less noise and signal loss. Most
analog (pre)amplifiers and stomp boxes have an input impedance of 1MegaOhm, so the best practice would be to
match the 1MegaOhm input impedance on your interface when using this plugin.

- Always make sure to have the highest input signal before the AD conversion, avoiding clipping.

- Amp and stomp box simulators are not noisy, they do not add noise. They’re a lot less noisy than analog hardware.
If you have noise issues, check your guitar’s electronic circuit, cables, and sound-card settings.

+ In almost all cases, amp and stomp box simulators do not introduce noticeable latency. Tonality: Will Putney doesn’t
introduce any noticeable latency. If you're experiencing latency issues, check your interface settings. Experiment
with your input buffer size. We recommend a setting of 128 samples.
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STL Tones Download Center

Please visit hitps://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.
STL Tones License System

 Your Activation License code will be in the confirmation email you received after your purchase.

« To login into your user account, go to www.stltones.com and click on the “Login” icon in the upper right-hand corner.
If you don’t have a user account, create one by clicking “Create Account” inside the same login window.

« Multiple Machines: Each activation code can be used on up to 3 different machines, however, the associated email
will always be the email entered during your first activation. If you try to activate the same code on a 2nd machine
with a separate email, the activation will fail.

« Trial Limitations: Only one trial can be requested per account or machine.

« The activation process is similar for trials and full licenses and is laid out below.



Installation and License Activation Page 9

Full License (Online Activation)

Access your account : « When you first open the plugin, you will be prompted to log in to
your STL Tones user account.

Login using your STL Tones account credentials

Email

]

Password
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Register your device [ x ]

This is the first time you attempt to login from this device.

In order to verify your identity, we'll send a Verification Code to your
account E-Mail address.

Enter it below and click "Verify" to register this device.

If you don't receive a Verification Code within 2 minutes, check your
spam folder.

Verification Code

Format: xxxxxx

-

+ You will receive an email to the address you provided from activations @stltones.com. This email contains your 6-
digit verification code. Copy this 6-digit code from your email and paste it into the Verification Code field in the
menu, then click “Verify”. Note: Check your spam folder if you didn’t receive a verification code.
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Activate your Product o0

We couldn't find a valid license for this product on this computer.

If you have purchased a license, you can activate it by clicking on
"Activate Product” and following the instructions.

If you don't have a license and want to trial the software, you can click
on "Activate Trial" to start your trial period.

Activate Product Activate Trial

Powered by Spirionix Signed in as: i

+ You will then be prompted to activate a license. Select “Activate Product”.
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© Activate your product (]

Please enter the Activation Code we sent to your account Email
address after your purchase to activate your product and click
"Activate”.

If you haven't received an Activation Code, check your spam folder.

Activation Code

[R5t el S e S0 S P e e S0 A |

Format: XXxXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX=XXXX

-

- This will take you to the activation screen. Enter your activation code and click “Activate”.

Activated

Your product is now activated on this computer.

You can activate this product on 2 additional machines.
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Trial License (Online Activation)

Access your account

Login using your STL Tones account credentials

Emaiil

]

Password

- When you first open the plugin, you will be prompted to log in to
your STL Tones user account.



Installation and License Activation

Page 14

Register your device

This is the first time you attempt to login from this device.

In order to verify your identity, we'll send a Verification Code to your
account E-Mail address.

Enter it below and click "Verify" to register this device.

If you don't receive a Verification Code within 2 minutes, check your
spam folder.

Verification Code

Format: xxxxxx

=D

+ You will receive an email to the address you provided from activations @stltones.com. This email contains your 6-
digit verification code. Copy this 6-digit code from your email and paste it into the Verification Code field in the
menu, then click “Verify”. Note: Check your spam folder if you didn’t receive a verification code.
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Activate your Product o0

We couldn't find a valid license for this product on this computer.

If you have purchased a license, you can activate it by clicking on
"Activate Product” and following the instructions.

If you don't have a license and want to trial the software, you can click
on "Activate Trial" to start your trial period.

Activate Product Activate Trial

Powered by Sp ix Signed in as: s e

+ You will then be prompted to activate a license. Select “Activate Trial”.
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© Activate your trial o

If you haven't evaluated this product yet, you can start your trial period
by clicking on "Activate Trial".

When in Trial mode, the product will be fully functional for the whole

trial period.
Activate Trial

- Select “Activate Trial”.

Activated

Your trial is now activated on this computer.

‘ Done
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Input and Output Controls

The Input control affects how much signal the plugin receives. This will affect the distortion range of the gain pots in
the Amplifier and Stomp Sections. Adjust according to your purposes and input signal levels. The Output will affect
how much signal the plugin sends out to your DAW channel. The meters will show if input or output signals are
clipping by appearing red. NOTE: To make the virtual circuits react naturally to your guitar playing, it is vital to use the
correct signal level, so we suggest using the input Level Listener feature located top-right of the input knob.

OO0 ©® & 10 e T

INPUT GATE TUNER STOMP BOXES AMPLIFIER CABINET MIDI OUTPUT

Input Level Listener: The Input Level Listener will assist in setting the plugin input level correctly.

Input Level Listener

1. Select your pickup type

2. Set your guitar volume potentiometer to max
@ 3. Adjust your soundcard input level to peak around -6dB
4. Play a few chords (5-10 seconds), the software will

automatically adjust the Input Level for best
performances

PICKUP TYPE

Medium Output v
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The preamp level on your sound card needs to be set correctly for the Input Level Listener to work as intended. It is
advised to leave around 6dB of headroom on the A/D converter. In most cases, your sound-card input meters should
peak below the "yellow" zone while playing normally. If the sound-card meters LEDs are mostly yellow or red
(clipping), turn the preamp level down until you're in the "green" zone.

Once you open the Input Level Listener panel, the plugin analyzes your input signal and adjusts the Input Level
control accordingly.

Once your input signal is set correctly, select the Pickup Type from the menu:

- Low Output is for single coil or vintage pickups with low sensitivity.
- Medium Output is for passive humbuckers with balanced output.
- High Output is for active or hot passive humbuckers.

Start playing and the software will adjust the input level according to your guitar signal and the selected Pickup Type.

Here are some reference values you should see in the Input Level Listener if you've set everything correctly. If you
see values that are extremely different from the reference levels, please adjust the sound-card preamp and repeat the
process:

- Low Output pickup: Input Level in the -6dB to -3dB range.
- Medium Output pickup: Input Level in the 0dB to +3dB range.
- High Output pickup: Input Level in the +6dB to +9dB range.
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Gate: Cuts unwanted noise spill, hiss or hum by setting a threshold at which the input signal needs to be above for
processing.

Tuner: Click to open the Tuner. The tuning indicator light will span from left to right and turn green when the note is in
tune (middle position). When using the Tuner, you can switch off the output sound of the plugin for convenience by
clicking the speaker icon button on the bottom left side of the window. If you want to change the master tuning
frequency to something other than 440Hz, you can do so by clicking on the reference text box on the bottom right
side of the window. NOTE: Tuner runs in a modal window, so all the other controls in Tonality: Will Putney are
disabled until you close the Tuner window.

)

SENSITIVITY REFERENCE
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Stomp Boxes: There are four available stomp pedal effects.
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Fuzz: There are eight controls for the Fuzz Pedal.

—t
.

LOUDNESS: Controls the amount of volume you are adding to the signal.

SUSTAIN: Controls the amount of fuzz distortion added to the signal.

FILTER: Adjusts the high-frequency response.

SCOOP: Adjusts the mid-frequency response.

CRUNCH: Adjusts the compression for subtle to more aggressive fuzz distortion tones.
Z SLIDER: Simulates the effect of changing the input impedance for the pedal.

CLIP: Adjusts the intensity of the smoothness and sustain of the fuzz.

©® N o g &~ w0 b

VOICE: Adjusts the intensity of the scoop control.
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Distortion: There are seven controls for the Distortion (Tube Screamer TS9/808) Pedal.

1.

2
3.
4

VOL.: Controls the amount of volume you are adding to the signal.

. TONE: Controls the amount of tonal frequencies you wish to add to the signal.

GAIN: Controls the amount of Gain you are adding to the signal.

LOW BOOST: Most overdrive pedals cut some low frequencies to achieve a tighter tone when boosting hi-gain
amplifiers. This model is no exception, but the Low Boost switch allows you to reduce that cut and bring the low
end back, which can be useful if you want to add dirt to your bass tone without losing the low-end.

TS9/808: Changes the overdrive output buffer to emulate the circuit of the famous TS9 and TS808 units. Keep in
mind that the difference is subtle when using the pedal at normal volume values, but crank the volume up and
you'll hear the difference. In TS9 mode you have a more transparent and tight sound, while in 808 mode the buffer
will saturate adding more even harmonics, enriching your tone.

CLIPPING: Changes the distortion character. When switched ON (toggle up), classic silicon diodes will be
replaced by LEDs, giving more headroom and a very aggressive tone.

+GAIN: Increases the gain of the clipping circuit, thus increasing the distortion and adding more compression to
the signal.
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Delay: There are eight controls for the Delay Pedal.

1. WET: Controls the mix of your signal, from 0-100%. 100% is for an equal mix. The dry signal always passes
unprocessed. When the mix is at 100%, the delayed signal has the same amplitude, therefore at 50%, the
delayed signal is lower.

2. F.BACK: Controls the feedback and repeats of the delay.

g

DELAY: Sets the delay time note value. This value can be synced to the DAW by clicking the 'BPM SYNC’
button. You can also use the 'Tap’ button to tap a specific delay time.

LO PASS: Filter that controls the EQ of the delay repeats from 1000Hz to 22050Hz.
HI PASS: Filter that controls the EQ of the delay repeats from 20Hz to 1000Hz.
DEPTH: Controls the modulation depth of the delay repeats from 0-100%.

RATE: Controls the modulation rate of the delay repeats from OHz to 10Hz.

© N o 0 &~

PRE/POST: Allows you to choose the delay position in the chain. Use PRE if you want the delay in front of the
amp, or POST if you want it in the loop of the amp. NOTE: You can only use the effect in Stereo routing mode
when the switch is in POST mode.
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Reverb: There are eight controls for the Reverb Pedal.

1. WET: Controls the balance of the dry and wet signal.

DELAY: Controls the delay time before the reverberated signal appears.

LENGTH: Sets the time of the reverb, from 0-10 seconds without temporal reference.
LO PASS: Filter that controls the EQ of the delay repeats from 1000Hz to 22050Hz.
HI PASS: Filter that controls the EQ of the delay repeats from 20Hz to 1000Hz.
DEPTH: Controls the modulation depth of the delay repeats from 0-100%.

RATE: Controls the modulation rate of the delay repeats from OHz to 10Hz.

©® N o a =~ w0 b

PRE/POST: Allows you to choose the reverb position in the chain. Use PRE if you want the reverb in front of the
amp, or POST if you want it in the loop of the amp. NOTE: you can only use the effect in Stereo mode when the
switch is in Post Mode.
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Amplifier: Select between the six available amp models.

1/0 Setup

r
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This model is based on a Peavey® 5150 II™ amplifier.

Amp 2
This model is based on a Bogner® Uberschall™ amplifier.

Amp 3
This model is based on a 1974 Mesa Boogie® Triple Crown™ amplifier.

Amp 4
This model is based on a Diezel® VH4™ amplifier.
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AMP 1: Based on a Peavey®© 5150 |[I™ lead channel, this amp is arguably one of the most well-known amps in the
metal industry. The ‘Focus’ knob controls the saturation behavior. When turned up, the overall gain will increase in the
high frequencies, making the distortion more saturated.
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AMP 2: Based on a Bogner© Uberschall™, this German-voiced high-gain amp is aggressive and is capable of some
of the smoothest, crunchiest tones in the high-gain realm. The ‘Focus’ knob controls the saturation behavior. When
turned up, the overall gain will increase in the high frequencies, making the distortion more saturated.
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AMP 3: Based on a 1974 Mesa/Boogie®© Triple Crown™ This rock ’n’ roll-voiced amp has two channels. CH1 for
American sounding clean-semi distorted tones, CH2 for thick high-gain. Normal’ & ‘Tight’ modes are on both channels
and control the picking attack, making the sound brighter or darker/softer depending on your needs.
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AMP 4: Based on a Diezel®© VH4™ | the tight precision that this amp produces is unparalleled. The two channels
cover a wide variety of gain needs.
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AMP 5: Based on an Ampeg®© SVT™, this revered vintage American bass amp from 1969 remains an unmistakable
part of the bass tones for many generations of musicians. The module has two channels; ‘Bright’ & ‘Normal’.
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AMP 6: Based on a Driftwood®© Purple Nightmare ™, this coveted high-gain amplifier is extremely versatile, capable
of extremely tight metal tones, and delicate cleans.
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Power Tube Options
Amps 1, 2, 3, & 4 allow users to switch between three of Will Putney’s go-to power tube options that he uses for these

amps. When changing between the different power tube options, the amp will react as it would with those different

tubes.

Amp 1: EL34, 6L6 & KT88
Amp 2: EL34, 6L6 & KT88
Amp 3: EL34, 6L6 & KT88

Amp 4: EL34, 6L6, KT88 & KT77
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Cabinet Section: Click the cabinet icon to open the Cabinet view. Here, you can change the internal cabinets and
internal IRs, as well as load external third-party impulse responses.
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Turning on the external impulse response loader turns off the internal IR.

PRESETS

01 Amp 1

Q) <>

INTERNAL CABINET

RESONANCE

O

O)r O ©

INPUT

Cab 1 - Matching Amp 1

GATE TUNER

STEIONALTTY

WILL PUTNEY

Normal Mode

100% O

[eeeee]

STOMP BOXES AMPLIFIER CABINET

ROUTING v2.0.0 ARM64

Mono

DISTANCE

RESONANCE
IMPULSE RESPONSE

No external IR Selected v i€|>h

n o C

MIDI OUTPUT




Main Interface Page 35

You can move the microphone around the speaker with 4 degrees of freedom: X (horizontal axis), Y (vertical axis), Z
(distance), and W (angle). You can further tweak your tone by using the featured HPF/LPF pass filters, Resonance
control, change the volume of each microphone by using the related volume slider, flip the phase with the related
button, link options for Distance, HPF, LPF controls and set the mix of the 2 mics to find the perfect balance.

To get the most out of the Cabinet section, you can change the microphone distance and angle using the related
knobs, however all 4 degrees of freedom are conveniently accessible directly via the crosshair by using key modifiers:
left-clicking your mouse and dragging will move the microphone in the X/Y axis, left-clicking+ctrl and dragging will
move the microphone on the Z axis, right-clicking and dragging will angle the microphone.

NOTE: You can bypass the cabinet section by clicking on the Cabinet icon in the footer controls while the Cabinet
view is open. Enable the ‘lock’ icon to lock the current cabinet when changing amps via the Amp Selector Button.
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There are twelve controls on the EQ module:
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1. Low Pass Filter Frequency: This control is stepped, with selectable values 22KHz, 16KHz, 12KHz, 8.2KHz,
5.6KHz or OFF. Slope is fixed at 18dB/Oct.

2. High Pass Filter Frequency: This control is stepped, with selectable values 36Hz, 60Hz, 105Hz, 185Hz, 330Hz
or OFF. Slope is fixed at 18dB/Oct.

3. Low Shelf Filter Frequency: This control is stepped, with selectable values 33Hz, 56Hz, 95Hz, 160Hz, 270Hz, or
460Hz. To be used in conjunction with the Low Shelf Filter gain control.

4. Low Shelf Filter Gain: This control is continuous and ranges from -16dB to +16dB. If you set the Low Shelf Filter
frequency to 160Hz and set this control to +3dB, all the frequencies below 160Hz will be boosted, keeping the rest
untouched.

5. Low Mids Peak Filter Bandwidth: Changes the width of the "bell" of the Low Mids Peak Filter. Turn it clockwise
for a narrower boost or cut when you need surgical equalization, or counter-clockwise for a broader and more
gentle effect.

6. Low Mids Peak Filter Gain: This control is continuous and ranges from -16dB to +16dB.

7. Low Mids Peak Filter Frequency: Select the frequency of the boost/cut for the Low Mids Peak Filter. This
control is continuous and ranges from 40Hz to 1200Hz.
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10.

11.

12.

High Mids Peak Filter Bandwidth: Changes the width of the "bell" of the High Mids Peak Filter. Turn it clockwise
for a narrower boost or cut when you need surgical equalization, and counter-clockwise for a broader and more
gentle effect.

High Mids Peak Filter Gain: This control is continuous and ranges from -16dB to +16dB.

High Mids Peak Filter Frequency: Select the frequency of the boost/cut for the High Mids Peak Filter. This
control is continuous and ranges from 600Hz to 18KHz.

High Shelf filter frequency: This control is stepped, with selectable values 8KHz, 15KHz, 10KHz, 6.8KHz,
4.7KHz or 3.3KHz. To be used in conjunction with the High Shelf Filter Gain control.

High Shelf Filter Gain: This control is continuous and ranges from -16dB to +16dB. If you set the High Shelf
Filter Frequency to 10KHz and set this control to +3dB, all the frequencies above 10KHz will be boosted, keeping
the rest untouched.
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Standalone application

Audio/MIDI Settings * Open the standalone app and click on the Audio I/O

Feedback Loop:

Output:

Input:

Active output channels:

Active input channels:

Sample rate:

Audio buffer size:

Active MIDI inputs:

| v ) Mute audio input

Universal Audio Thunderbolt
Universal Audio Thunderbolt
(v)MoNL
() MoNR
(JunEes
(JuNE4

(v] MIC/LINE/HIZ 1
() MIC/LINE 2

() monNL
() MoNR

48000 Hz

512 samples (10.7 ms)

I

Bluetooth MIDI

button.

« Select the MIDI inputs (device) connected to the

computer you want to use.



MIDI Page 29

- Enable the MIDI Learn functionality by right-clicking on one
of the Tonality plugin model's learnable controls, a popup
. : menu will appear with two MIDI binding options:

MIDI Learn - Preset r."_., ,
MIDI Learn - Global J . ,} MIDI Learn - Preset: This will store the MIDI bindings at the

Preset level. Preset-level bindings have priority over Global
Bindings, meaning that assigning a MIDI PC or CC message
at the preset level will override existing bindings of the same
messages at the Global level if any. Preset-level bindings
are saved within the active preset and recalled when the
preset becomes active. Remember to save the preset using

DELAY

LOPASS LENGTH HI PASS

gl the Preset Manager (check the Header Controls section) if
/ you want to persist the MIDI bindings.
DEPTH RATE MIDI Learn - Global: This feature will store the MIDI
) bindings globally for the application/plugin. Global bindings
NSO . .
are shared among presets, meaning the registered MIDI
NATURE assignments will remain active even when changing presets

(unless overridden by a Preset level assignment as
described above).

« Once you select the binding type, the application will notify you that it’s ready to perform the assignment. Press the
MIDI control you want to assign to the selected parameter/functionality on the MIDI controller and the binding will
be stored, making the MIDI Learn popup menu disappear. You can now adjust that plugin parameter value using
the connected MIDI controller.
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Using a MIDI message to change a preset

MIDI BINDINGS

Global Bindings Preset Bindings

Feature Message Content
Preset - Next None
Preset - Previous None
Tap Tempo None
Tuner - Show/Hide None

Parameter Message

Action

Action

- If you want to recall a specific preset using your MIDI
controller, all you need to do is load the preset you want
to assign the MIDI message to, right-click on the preset
menu located in the left section of the header, and select
MIDI Learn - Global. This will trigger the previously
described MIDI Learn functionality and the provided
MIDI message will be bound to recall that preset. This is
very useful in a live-playing situation.

- The same can be done with the Previous/Next Preset
buttons placed on the sides of the preset menu if you
want to use your MIDI controller to switch from a preset
to the next or previous one without the need to reach
your computer. These types of bindings can only be
stored at the Learn Global level.

- All stored MIDI assignments can be reviewed and modified in the MIDI settings panel, accessed by clicking on the

MIDI icon in the plugin’s footer section.
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Resize: Click to resize the plugin interface. There are three possible values available: 50%, 75%, and 100%. In
addition to these 3 modes, you can fine-tune the size using the resize function in the bottom right corner.
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Normal Mode

Presets: The preset manager is divided into 3 sections:

- Load: In the Load section you’ll find all the available banks where each

PRESETS
bank entry has a submenu featuring all the presets it contains.

01 Amp 1

Load

v 01 Putney Guitar Tones - Create: Under the Create section, you can either add a preset to the
02 Putney Bass Tones current bank or create a new bank entirely. When creating a new bank, the
03 Album Guitar Tones currently loaded preset will be copied into it, you can tweak it later using

04 Album Bass Tones the edit options.

05 Additional Bass Tones

06 STL Tones

. - Edit: Under the Edit section, you can save changes to the current preset

e or bank file you are working on. NOTE: If you want to copy settings from
Current preset one instance to another track in a DAW project, you can use the Edit >
Current bank Current Preset > Copy function.

Create

New Preset

New Bank
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Normal Mode: When in Normal Mode, you are using a single amp and single cab combination.
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Mixer Mode: After the Stomp Boxes Section, the signal is split into 2 amps and 2 cabs running in parallel.
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After the cabinets, use the rotary knobs to decide the output level of each chain separately, and the possibility to
easily mix the two chains (we'll call "A" the top one, "B" the one at the bottom) using an additional fader right before
the EQ stage. Move the fader toward the chain you want to be dominant in the mix, so up for "A" and down for
“B”.Click on the fader to see how much percentage of each chain you're using. A great advantage of this fader is that
it keeps the output level consistent for all its excursions, so you'll easily figure out the sweet spot of your chains.
Phase polarity of every amp and cab in the plugin is matched (different amps may have opposite phase depending on
the particular circuit), so you do not need to worry about phase cancellation when changing amps back and forth.

Tempo (BPM): Set the desired tempo for the plugin (Standalone mode only). NOTE: Tempo is saved at the preset
level.

TEMPO (BPM) ROUTING v2.0.0 ARM64
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Routing: Tonality: Will Putney supports three different routing modes: Mono, Mono/Stereo, and Stereo.
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Normal Mode

- Mono: All the plugin sections will process the signal in mono.

- Mono/Stereo: All the plugin sections will process the signal in mono mode until an element supporting the “Mono-
To-Stereo-Split” is encountered. When this happens, the signal is split and the remaining elements in the chain will
automatically switch to stereo processing. Delay and reverbs are typical models supporting the “Mono-To-Stereo-
Split”, so when using those pedals in Mono/Stereo routing mode, the signal will be split and the subsequent effects
will work in stereo mode until the signal reaches the output.

- Stereo: All the plugin sections are internally doubled and will process the signal in stereo (left + right).

- Routing Lock: Click the lock icon in the current routing mode to audition different presets that maintain the routing
untouched and avoid overrides. Since the routing mode is saved in the preset itself, loading a Preset will change it.

NOTE: In the plugin versions of Tonality: Will Putney, if the Routing menu only features the “Mono” option, you’ve
most likely loaded it into a mono track. Use a stereo track if you want to enable the other routing options. Tonality: Will
Putney (standalone only) if the routing menu only features the “Mono” option, please check the setup in the output in
the Audio I/O settings. Enable at least two outputs from the Audio I/O menu, close the application, and re-open it. You
should now see all the routing options available.
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For technical issues or any problems experienced with our software contact us via the contact page at
www.stltones.com.

Before doing so, follow our troubleshooting questions below to see if these fix your issue:

Support Information to be provided

- To help us assist you in the best way possible, please provide the following information to our support team:
« Product Version Number (e.g. Tonality: Will Putney v2.0.0)

- Version number of your DAW (e.g ProTools 2021.12.0)

- Interface/hardware (e.g. Focusrite Scarlett 2i2, Universal Audio Apollo Twin, etc.)

- Computer and operating system info (e.g. Macbook Pro OS X 11.5.1, Windows 10 ver 1709, etc.)

- Please include a detailed description of your problem.
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Uninstall / Reinstall

This will repair possible broken permissions, fix corrupted files, and remove old versions of our software.

Steps:

1. Close out of all host software (Pro Tools, Logic, Cubase, etc.)

2. Uninstall your plugin.

3. Open your host software and ensure that the plugins are no longer showing up in the inserts list. If the plugins are
still present, locate the files on your computer and remove them manually. Once they no longer show up in your DAW
(after restarting it), move on to step 4.

4. Close out of all host software.

5. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual, making sure you have the latest installers for the plugin.

6. Run the latest installers and start your host program.

7. Follow the STL licensing prompts, ensuring that your host program is reading the latest version of our software.
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Repair permissions on your computer
Instructions: Run your host software as an administrator (Windows-only)

This can fix a variety of issues that result in crashing or error messages on Windows DAWSs that are loading our
plugins for the first time.

1. Exit your host program (Pro Tools, Cubase, etc.)

2. Right-click on the icon for that host program and select “Run as an Administrator.” You will only have to do this
once, meaning you can open up the host program normally the next time.
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How do | find my plugin in Reaper?
If you cannot find your STL Tonality: Will Putney plugin in Reaper, follow these steps to make the plugin available:

1. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual, ensuring you have the latest installers for the plugin.

2. Now check if the plugin is installed on your computer in the default folder.

File Locations: Mac
VST: Macintosh HD/Library/Audio/Plugins/VST/STL Tonality - Will Putney

File Locations: Windows
64-bit VST: C:\Program Files\VSTPIlugins\STL Tonality - Will Putney

If you don’t find the respective files, please reinstall your STL Tonality: Will Putney Product. If the relevant plugin files
are in the above folder, perform a rescan:

1. In Reaper, press [Ctrl] + P (Windows) / [Cmd] + [,] (Mac) to access Preferences.
2. Goto Plugins > VST

3. Under “VST Plugin Path,” make sure that the following path is listed (if not, add it):
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Windows: 64-bit VST: C:\ Program Files \ VSTPIlugins \ STL Tonality - Will Putney
Mac: System HD > Library > Audio > Plugins > VST
Click on Clear Cache/Re-Scan. Create a new session with a supported sample rate, add a track, and load your STL

Tonality: Will Putney plugin. If the pop-up window tells you to activate, please follow the installation and licensing
procedure outlined in the “Installation & License Activation” section of this manual.
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How do | find my plugin in Pro Tools?
If you cannot find your STL Tonality: Will Putney plugin in Pro Tools, follow these steps to make the plugin available.

1. Follow the installation and licensing procedure outlined in the “Installation & License Activation” section of this
manual, ensuring you have the latest installers for the plugin.

2. Now check if the plugin is installed on your computer in the default folder.
VST: Macintosh HD / Library / Audio / Plugins / VST / STL Tonality - Will Putney
AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins /STL Tonality - Will Putney

Windows: 64-bit VST: C:\Program Files\VSTPIugins\STL Tonality - Will Putney
Windows: 64-bit AAX: C:\Program Files\Common\Files\Avid\Audio\Plugins\STL Tonality - Will Putney

If you don’t find the respective files, please reinstall your STL Tonality - Will Putney Product. If the relevant plugin files
are in the above folder, perform a rescan:

1. To do a Rescan, you must delete certain files on your computer depending on your Pro Tools version. Please
follow the official Avid website to do this.



Troubleshooting Page 53

The plugin makes no sound at all, why is this happening?

You have most likely not activated the software yet, or the license file has moved to a different location and the
software can't find it anymore. Follow the installation and licensing procedure outlined in the “Installation & License
Activation” section of this manual, making sure you have the latest installers for the plugin.

Where do | find the installers?

Visit https://www.stltones.com/pages/file-downloads where you will find the latest installers for your product.

Where is the STL Tonality Plugin located on my computer?

Mac:

AudioUnits: Macintosh HD / Library / Audio / Plugins / Components / STL Tonality - Will Putney

VST: Macintosh HD / Library / Audio / Plugins / VST / STL Tonality - Will Putney

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins / STL Tonality - Will Putney
Windows:

64-bit VST: C:\ Program Files \ VSTPIlugins \ STL Tonality - Will Putney

64-bit AAX: C:\ Program Files \ Common Files \ Avid \ Audio \ Plugins \ STL Tonality - Will Putney
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Plugin Development: Federico Berti (Ignite Amps) and Dylan Slocum

Plugin GUI: Sonny Truelove and Dan Dankmeyer

Need more help?
Find technical support and instructions here: www.stltones.com/pages/contact-us

Contact our friendly Support Team here: www.stltones.com/pages/submit-a-request

Sincerely,

STL Tones Team



